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n the preceding Introduction, you became acquainted with some R basics: objects, functions, vectors, and data
frames. For this book, we have developed a more specialized collection of additional objects and functions that
will permit you to analyze, present, and interpret data. A specialized collection of R elements is called a package.
The package we have created for this book, “poliscidata”, contains the functions and datasets we use in this book
and is available through an online repository. In this section, you will (1) run the install.packages function to
install the poliscidata package, (2) run the library function to load the poliscidata package contents, and (3) run
the poliscidata package’s welcome function to produce some basic information about your working environment.
To install the poliscidata package, enter the following command:
# install bundled datasets and
# functions for R companion

D

o

install.packages(“poliscidata”)

This command will prompt you to select a repository from which to download the poliscidata package.
The repositories mirror one another, but you may want to select a repository close to you to save download time.
See Figure 1.1.
You can also download an R package by selecting the “Install package(s) . . . ” option under the Packages
menu. This method will also prompt you to select a nearby repository to download the package from, and then
select the “poliscidata” package from the long alphabetical list of R packages.
You will need to install the poliscidata package on each computer you use. When you install the poliscidata
package, R will automatically install the functions and datasets you’ll be using as well as the packages that the
poliscidata package requires. The installation process may take a couple of minutes.

Aquino, J. (2012). descr: Descriptive statistics (R package version 0.9.8). Includes R source code and/or documentation written
by Dirk Enzmann, Marc Schwartz, and Nitin Jain. Available at http://CRAN.R-project.org/package=descr
13
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Installing R Companion’s Package
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Figure 1.1
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You might wonder why the R program does not come with all the packages you need. There are thousands
of different packages available to extend R’s capabilities. Chances are, you will use only a fraction of them
(even if you become a lifetime R user). So the R Project keeps the base version of the program relatively light and
allows users to add on functionality based on their individual preferences.

co
py
,

Box 1.1 Missing Packages
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When you install the poliscidata package, R should automatically install all the packages that our package
depends on. We’ve found, however, that R sometimes fails to install all the required dependencies. If this
happens, you will see an error message that you are missing a required package. Don’t panic. You can fix this
problem pretty easily. You just need to install the missing packages manually. You can either select the “Install
package(s) . . . ” option from the Packages drop-down menu, select a repository near you, and select the missing
package from the very long list of available packages, or you can type:
install.packages("name_of_missing_package")

D

o

on the Console command line, substituting the name of the missing package where indicated. If R reports that it
is missing another package, keep installing missing packages until the missing package error messages go away.
You will not have to do all this each time you use R. It is simply a set-up issue.

Now that you’ve downloaded the poliscidata package, you need to load the package in your current
R session using the library command. When you download R packages, they aren’t automatically available every
time you use R. The program allows you to selectively load installed packages so you can make efficient use of
your computer’s memory. It might be helpful to think about R packages likes apps you download to your phone;
your phone doesn’t come with all available apps pre-installed: It lets you pick and choose which ones you want.
After you’ve downloaded an app, you have to open it to use it; you don’t want all your phone apps to open and
run automatically.
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After you’ve installed the poliscidata package, you load it with the library command. You can also load the
poliscidata package by selecting the “Load package . . . ” option under the Packages menu. See Figure 1.2.
library(poliscidata)

Loading R Companion’s Package
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Figure 1.2

# Loads R companion package in session
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When you execute the library(poliscidata) command, it may look like R didn’t do anything. Actually, there
is a lot going on behind the scenes, but R won’t output any messages to the console unless there is a problem.
We created the poliscidata package to make getting started with R as simple and as straightforward as possible.
At this point, you should be ready to go.
To acquaint you with the R working environment and the contents of the poliscidata package, we’ve
written a special function called welcome. This command will generate a welcome message, output some basic
information about your R session, and list the objects and functions in the poliscidata package.
# introduction to the companion environment
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welcome()
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The circled objects on the list above are the four datasets that you will analyze: gss, nes, states, and world.
(For a detailed description of the datasets, see Box 1.2.) You’ll also notice that the package contains four objects
with similar names as our four datasets: gssD, nesD, statesD, and worldD. These are special design datasets that
are used by a useful suite of functions that analyze weighted data.
The list of objects and functions in the poliscidata package may look pretty long at first, but we’ll introduce
them gradually and, with some practice, you’ll learn how to use all sorts of R functions to analyze politics.
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Box 1.2 The Companion Datasets
The poliscidata package has four datasets.
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1. gss. This dataset has selected variables from the 2012 General Social Survey, a random sample of 1,974
adults aged 18 years or older, conducted by the National Opinion Research Center and made available
through the Inter-university Consortium for Political and Social Research (ICPSR) at the University of
Michigan. Some of the scales in gss were constructed by the authors. The variables in the gss dataset
are described in the Appendix (Table A.1).

2. nes. This dataset includes selected variables from the 2012 National Election Study, a random sample of
5,916 citizens of voting age, conducted by the University of Michigan’s Institute for Social Research and made
available through ICPSR. See the Appendix (Table A.2).
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3. states. This dataset includes variables on each of the 50 states. Most of these variables were compiled by
the authors from various sources. A complete description of variables in the states dataset is found in the
Appendix (Table A.3).
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4. world. This dataset includes variables on 167 countries of the world. These variables are based on data
compiled by Pippa Norris, John F. Kennedy School of Government, Harvard University, and made available to
the scholarly community through her Internet site. See the Appendix (Table A.4) for a complete description of
variables in the world dataset.
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The four datasets included in the R package that accompanies this book contain a wealth of information
about political behavior and institutions. We’ll use these datasets to demonstrate a variety of research methods,
but we hope your curiosity will be sparked to explore variables and relationships that we don’t address here. To
see the names of variables contained in the datasets, you can use the names function. For example, the following
command will return the names of all the variables in the world dataset.
names(world)

“country”
“dem_rank14”
“lifeex_m”
“pop_0_14”
“fertility”
“religoin”
“spendmil”
“sexratio”
“gender_unequal”
“lifeex_total”
“confidence”
“dem_other5”
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[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]
[25]
[28]
[31]
[34]

# list names of variables in dataset

“gini10”
“dem_score14”
“literacy”
“pop_15_64”
“govregrel”
“spendeduc”
“hdi”
“pop_total”
“gender_unequal_rank”
“debt”
“decent08”
“democ”

“dem_level4”
“lifeex_f”
“oil”
“pop_65_older”
“regionun”
“spendhealth”
“pop_age”
“pop_urban”
“arda”
“colony”
“dem_other”
“democ11”
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“district_size3”
“enpp3_democ”
“eu”
“frac_eth”
“free_business”
“free_fiscal”
“free_labor”
“free_trade”
“gdp08”
“gdp_cap3”
“gdpcap08_2”
“gender_equal3”
“hi_gdp”
“natcode”
“polity”
“regime_type3”
“unnetgro”
“unremitp”
“votevap00s”
“women09”
“womyear”
“democ.yes”
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“democ_regime08”
“effectiveness”
“dnpp_3”
“fhrate08_rev”
“frac_eth3”
“free_finance”
“free_invest”
“free_property”
“free_overall_4”
“gdp_cap2”
“gdpcap3_08”
“gdppcap08_3”
“gini08”
“muslim”
“pmat12_3”
“protact3”
“unions”
“unpovnpl”
“vi_rel3”
“women05”
“ipu_wom13_all”
“dem_economist”
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“democ_regime”
“durable”
“enpp3_democ08”
“fhrate04_rev”
“frac_eth2”
“free_corrupt”
“free_govspend”
“free_monetary”
“free_overall”
“gdp_10_thou”
“gdpcap2_08”
“gdppcap08”
“gini04”
“indy”
“oecd”
“pr_sys”
“rich_democ”
“unnetuse”
“unremitt”
“votevap90s”
“women13”
“womyear2”
“country1”
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[37]
[40]
[43]
[46]
[49]
[52]
[55]
[58]
[61]
[64]
[67]
[70]
[73]
[76]
[79]
[82]
[85]
[88]
[91]
[94]
[97]
[100]
[103]

e
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An important note to commit to long-term memory: Each time that you open a new session to work with
the poliscidata package, you will need to execute the following command:
library(poliscidata)
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As we noted above, you can also load the poliscidata package using the “Load package” option under the
Packages menu tab. We encourage you to use R commands when possible because you can save a series of
commands in a script file (more on using scripts below).
We’ve designed this material so you can start analyzing real political science data with R quickly and easily.
You may still encounter some problems or receive some unexpected warnings from the R program. You might
also see a warning message that one or more packages were built under an earlier version of R than the one you
are running. This issue does not seem to pose any serious problem.

RUNNING SCRIPTS
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In this book, you will create, run, and save R scripts. R scripts (called R documents on Mac OS) are
documents that contain the lines of code you want R to execute (as well as comments that make your
scripts easier to read and understand). You can think of an R script as a set of step-by-step instructions for
the R program.
By this point, you probably have already executed some R commands successfully from the console’s
command line prompt, so why bother opening another window in the program and creating a script file?
Sometimes getting R to do what you want it to do is tricky, so when you figure out what works, it is a good
idea to save your work so you won’t make the same mistakes again. If you are going to execute the same
commands repeatedly, like the lines of code you need to execute each time you work with the R Companion,
save those commands in a script file, making it easy to repeat them. Just like you save someone’s phone
number so you can call or text them at the touch of a button, rather than manually entering each digit of their
number every time you want to contact them, saving your work in well-written script files saves time and
prevents mistakes.
To create an R script, select the “New script” option under the File menu tab (or press Ctrl-N). If you’re
running R on a Mac OS, your version of R will say “New document” rather than “New script”.
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R Script Editor
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Figure 1.3
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The unassuming R script editor should now appear. Click in the script editor and type a couple of
lines (refer to the Introduction for sample lines of R code). When you finish typing a line of code and
start a new line, the line you’ve completed isn’t automatically executed. You can run lines one at a time
by clicking on the line and pressing Ctrl-R. (If you are running Mac OS, you’ll execute a line of code by
pressing Command-Enter.) You can also select the “Run line or selection” option from the Edit menu tab
or right-click the line and select “Run line or selection” from the pop-up menu, but you’ll find the keyboard
shortcut a time-saving practice. R will execute the line of code the cursor is on and get ready to run the
next line.
When you execute a line of code from the script editor, R reacts just like you entered that line of code at the
command prompt in the console widow. In fact, if you look closely at the Console output, you’ll see that when
you execute a line of code from your script, the line you ran appears in the Console window.
To run multiple lines of code at once, select (highlight) the lines of code you want to run and press Ctrl-R
(or the “Run line or selection” options discussed above). You can run an entire script at once by pressing Ctrl-A
and then Ctrl-R (or the “Run all” option from the Edit menu).
Sometimes it’s very helpful to run just a fragment of a line of code. We often do this to debug a line of code
that’s not working the way we expected. You can run part of a line of code by highlighting part of the line and
pressing Ctrl-R (or the alternatives discussed above).
After you’ve had the chance to write and run a couple lines of test code from the script editor, let’s learn
how scripts are saved and re-opened. This is the big advantage of writing a script, rather than entering command
line statements: You can save your work and pick up from where you left off later. To save your test script, press
Ctrl-S, the ubiquitous keyboard shorthand for save. Give the script a descriptive filename, such as “testScript.R”.
Make sure to type the entire filename, including the .R extension. You might want to create a folder for your
R scripts; you’ll hopefully be developing a nice, well-organized collection soon. Feel free to close your script
and even quit the R program.
To re-open a script and continue working with it, you’ll need to start the R program first and
select “Open script . . . ” under the File menu. The R program doesn’t automatically launch when you
double-click an .R file the way double-clicking a word document launches a word processor. The
.R extension helps the R program recognize a script file, so it is a good script-naming practice to follow.
Your test script may not be especially useful moving forward, but getting in the habit of writing good
R script files will pay dividends.
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TEN TIPS FOR WRITING GOOD R SCRIPTS
Just as you can learn to write good essays, you can learn to write good code for a computer program. In fact,
many of the principles you’ve learned for composing effective prose apply just as well to writing good R code.
Following these suggestions will save you time and aggravation.
1. Good scripts are user-friendly. We write R code for our benefit, not the computer’s. (To the computer, it
all becomes a stream of 0s and 1s.) So you should write scripts that are clear and comprehensible to you.
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2. When you create objects or generate new variables, give your creations clear, descriptive names. You
aren’t limited to names with a limited number of characters, like some old computer programming
languages. Avoid the temptation to give objects fanciful, humorous, or arbitrary names (they won’t be
very amusing when they give you problems).
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3. Understand how R treats white space and line breaks. R will interpret the space between words as
the separation between objects. If you want to give an object a multi-word name, use underscores or
periods to connect the words, or use camelCase (capitalizing the first letter of each subsequent word).
If you enclose words in parentheses, R will interpret the quoted expression as a value to be assigned
to an object or passed to an argument in a function. If you want to include a quotation mark, or some
other special characters, as part of a quoted expression, you need to use special escape sequences. (Enter
?Quotes for more information.) R will interpret line breaks as the start of new commands. Sometimes,
you’ll want to execute long lines of code that are more easily read and edited if broken into several lines.
You can enclose multiple lines of code in parentheses and R will then interpret everything enclosed in
parentheses as belonging to the same command. We’ll take advantage of this feature to demonstrate
how to use functions with multiple arguments.
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4. Lines of code that work together to complete a particular task should appear like single-space text in a
script. A block of code is a set of instructions that complete a single task, are run together, and look like
a block in a script file. Lines of code that complete another task should be separated into another block.
For example, your script should keep a block of statements that transform a dataset variable together,
a block of statements that create a graphic together, and a block of statements that estimate a statistical
model together. It’s the same logic you follow when you use paragraphs to organize an essay. You use
several sentences to express some idea in a single paragraph and when you’re ready to move on to a
new idea, you start a new paragraph.
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5. Easy on the eyes, easy on the brain. Use comments, white space, and line breaks to write
subheadings and create visual separation in long scripts. Comments are statements intended for
human readers that R does not attempt to execute. Anything you write on a line to the right of a
# sign is strictly commentary (including more # signs).
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# ------------- Create Plot of Multiple Regression Results ---------------

Format longer scripts using comments, spaces between lines, and indentations, just as you would use
subheadings, paragraphs, and punctuation to organize words in an essay. You want to be able to quickly
skim a script to understand its basic design and purpose. This will help you locate particular lines that
you want to copy or revise.

6. Use comments like “sticky note” reminders to yourself. For example, one of the early lessons in this
book is how to generate descriptive statistics for different types of variables. When you learn how to
produce a frequency table for an ordinal-level variable, insert a comment in your script like:
# Create frequency table for ordinal-level variable
# The w and plot arguments are optional
freq(x=nes$budget_deficit_x, w=nes$wt, plot=FALSE)
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This work may not be reproduced or distributed in any form or by any means without express written permission of the publisher.

20 Chapter 1

There’s a good chance you’ll be asking yourself at the end of the term how you created the frequency
tables you made early in the term. If you follow these suggestions, you’ll find a script called something
like “describingVariables.R” on your computer and when you open it, you’ll see your comment telling
you which line(s) of code create the descriptive statistics you need. (Feel free to pat yourself on the back
at this point.) What may seem like a few minutes of extra, unnecessary work in the moment will save
you hours of time in the long run.
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7. Save your scripts with names that clearly describe what the script does. For example, when you write an
R script that makes comparisons between groups, save that script with a name like “makingComparisons.r”.
Don’t save it with a name like “homeworkForClass.r” or “assignment4.r” because those names aren’t
going to help you find the code you want to use to solve a problem in the future. Write separate scripts for
separate projects, just like you have different work documents for different papers.
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8. Set a working directory to keep your files organized. Use a separate working directory for each project.
If you’re using this book as part of a class, create a directory for your class. If, subsequent to taking this
class, you want to apply some of the research methods you’ve practiced to analyze data in a paper or for
a project, you’ll have a well-organized toolkit at your disposal.
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9. Type the name of objects and variables as seldom as possible. Each time you type the name of an object
or variable, there’s a chance you type it incorrectly. Instead, to use an object declared earlier in your
script, highlight the object’s name, copy it, and paste the copied name where you need to reference it. If
you are executing a statement that’s similar to one you’ve already written, copy and paste what you’ve
already written and then edit only those parts of the copied code that needed to be changed to complete
the task at hand. If you’re working on a project that’s similar to one you’ve worked on before, re-use
your earlier work as much as possible.
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10. Save your scripts frequently in case R stops responding. It’s a stable program, but it will occasionally
seize up. Even better, save your work on some kind of Cloud storage so it’s convenient for you to work
on multiple machines.

MANAGING R OUTPUT: GRAPHICS AND TEXT

no
t

co
py
,

For practically all of the examples and exercises in this book, you will produce and interpret text output—
frequency distributions, cross-tabulations, tables of regression coefficients, and so on. Quite often, you will want
to create an accompanying graph or chart, such as a mosaic plot or scatterplot. R graphics are remarkably easy to
work with: Create them, print them, or copy/paste them into a document, such as a Word document. By
contrast, nicely formatted text requires a bit more work.
To illustrate, we will use the freq command (from the descr package) to obtain a frequency distribution
(text) and bar chart (graphic) of nes$pid_x, a measure of party identification.2 The nes dataset needs to be
weighted, so we will include the weight variable, nes$wt, in the freq command. (Be sure to read Box 1.3, A
Special Note on Weights). At the prompt or in the script file, type and run the following function call:
# Example: graphics and text output

o

freq(nes$pid_x, nes$wt)

D

nes$pid_x
Frequency Percent Valid Percent
StrDem
1156.02 19.5405
19.61
WkDem
890.31 15.0492
15.10
IndDem
690.86 11.6778
11.72
Ind
839.33 14.1875
14.23
IndRep
720.81 12.1841
12.22
WkRep
731.41 12.3632
12.40
StrRep
867.52 14.6640
14.71
NA's
19.74
0.3337
Total
5916.00 100.0000
100.00
2

Chapter 2 covers the freq command in detail.
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Box 1.3

A Special Note on Weights
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Sample R Graphics Output
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The states and world datasets are unweighted. In analyzing unweighted data, you do not need to adjust
for sampling bias, because each state or country is equally and adequately represented in the dataset. For
example, to calculate the average percentage of women in parliaments of the world (recorded in the variable
world$women09), you would ask R to sum the percentages for each country and divide by the number of
countries.
By contrast, the gss and nes datasets must be weighted. Why is this? In unweighted form, these
datasets contain sampling bias—that is, some groups are over- or under-represented when compared with
the overall population of adults. So, for example, if you wanted to calculate the average age of respondents
in the nes dataset, the unweighted average would be distorted, because not all age groups are equally and
adequately represented in the dataset. To correct for this bias, survey designers provide sampling weights.
Therefore, in order to obtain accurate results from the two survey datasets, gss and nes, you will need to
weight your analyses by the appropriate sampling weight. For nes, the weight variable is nes$wt; for gss,
it is gss$wtss.
Most of the base R functions do not permit sampling weights. Fortunately, the extra packages you installed
in this chapter contain procedures that can be used with weighted data (such as gss and nes) or unweighted
data (such as states and world). On rare occasion, however, you will learn separate procedures, one for weighted
data and one for unweighted data.

StrDem

WkDem

IndDem

Ind

IndRep

WkRep

StrRep
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Consider the results. As you can see, R creates a graphic, a bar chart of nes$pid_x, and displays it in a
separate window. If you’re using Windows, you can right-click on the graphic to copy or save the figure in a
desired format, or you can print it directly. Not too much to it. An editable version of the console’s frequency
distribution table, on the other hand, requires a few additional steps. There are a couple of ways to manage
R Console output. You’ll frequently want to incorporate the results of your analysis into documents.
To incorporate R Console output into informal documents, like rough drafts of papers or class
assignments (check with your instructor though), you can copy text from the R Console and paste it into
a word processor. The result typically looks disorganized and confusing because the pasted text appears
in your word processor’s default font, which is typically a proportional font (such as Times New Roman).
If you change the font used to display R Console out in a Word document to a monospace font (such as
Courier New or Lucida Console), you can replicate the basic formatting of tabular results you see in the
R Console.
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Simple Table Formatting
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Figure 1.5
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For more formal presentations, like final drafts of papers or any analysis you plan on sharing with an audience,
you should edit and format Console output. The printC function will export R tabular output as an .html file to
your working directory. These files can subsequently be opened in a web browser, copied/pasted into a document
file such as Word, and then edited for appearance and readability. The printC function will create an .html file,
named “Table.Output.html”, that will be the repository for all the tables you wish to export, edit, and print. To
create an editable table using the printC function, insert the desired command within printC’s parentheses.3 For
example, to print the frequency distribution table for nes$pid_x using the printC function, enter the following:
# Print table output to html file

co
py
,

printC(freq(nes$pid_x, nes$wt))
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This statement quietly exports the frequency distribution to Table.Output.html in the working directory. If
you don’t know where to find the Table.Output.html file, enter the getwd() command. (See the section “Creating
Tables of Regression Results” in Chapter 8 for more instruction on the printC command and formatting tables
for formal works.)

ADDITIONAL SOFTWARE FOR WORKING WITH R
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In this section, we discuss some options to making the R environment easier to use. As we’ve discussed, the
R environment is relatively spare and efficient. Its graphical user interface is limited and little analysis can be
conducted using its pull-down menus. Fortunately, some software developers are working to address this void
and make R more intuitive and user-friendly. We’ll take a look at two of these developments, R Studio and
R Commander.
R Studio is an interface for R that is available for Windows, Mac OS, and Linux. It’s a free program
(commercial enterprises may pay more for technical support). You can download R Studio and learn more
about it from its website: https://www.rstudio.com/. For new R users, R Studio has some excellent features. We
particularly like R Studio’s ability to suggest and auto-complete code. If you look closely at the screenshot in
Figure 1.6, you’ll see that when we type “nes$” we get a pull-down menu of variables in the nes dataset, a very
helpful feature. Other nice features include an enhanced Editor with line numbers and smart text coloring, a
command history pane, a help file pane, and some nice options for saving graphics.
If you get an error message that says “function not found”, that means you either haven’t loaded the companion packages or
didn’t type the name of the function correctly.
3
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R Studio Screenshot
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Figure 1.6

co
py
,

R Commander is an R package that allows users to execute a suite of commands using drop-down menus
and a graphical user interface. If you have used statistics programs like Stata or SPSS before, you might like the
look and feel of R Commander. Once you have R up and running, it’s easy to install and load R Commander:
# Install and load the R Commander package
install.packages(“Rcmdr”)
library(Rcmdr)

R Commander Screenshot
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Figure 1.7

(Continued)
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(Continued)
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Figure 1.7
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Of course, not all R packages and functions are integrated into R Commander, but the package makes some
of the most commonly used statistical methods easy to use.

DEBUGGING R CODE
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When you execute a statement in R, you might get an error message telling you that an action you performed
did not achieve the desired result. In fact, this happens all the time. Learning how to identify and correct
mistakes is how you practice and develop your skills as an R user. Error messages are different from—and worse
than—warning messages, in which R simply makes note of something it encountered while executing a
command, such as missing data.
In our experience working with students, most errors are caused by typos and minor syntactical mistakes.
When you type the name of an object or function incorrectly, you typically get a “Function not found” or
“Object not found” message. If you see these error messages, carefully check how you’ve spelled the name of the
function or object that’s not found. Remember that R is case sensitive and will interpret a space between words
as the beginning of a new object or function.
Test lines of code as you write them. Don’t wait until you’ve written all the commands you think necessary
to complete a task before running the code. Remember that R can run code one line at a time, just part of a line,
or all lines at once.
If you are working with a function that has many arguments, start by executing the function in its most
basic form and add arguments incrementally. Most R users start by finding a working example that’s similar to
what they want to do and adapting the example to suit their needs. It’s an iterative process with a lot of trial and
error. Functions that create graphics are a good example of this. The best way to create beautiful graphics in
R is to start with a basic working figure and then refine that figure by defining values for optional arguments and
adding layers of information.

Copyright ©2018 by SAGE Publications, Inc.
This work may not be reproduced or distributed in any form or by any means without express written permission of the publisher.

The R Companion Package 25

po
s

t,
or
d

is
t

rib
ut

e

If your function call isn’t working, test each executable component of a function call. For example, if you’re
applying a function to a variable, highlight the name of the variable and run it to see its contents. Are you
applying the function to a variable that isn’t there or is not in the form you expected? One of the most common
errors that a user makes when working with a variable is not specifying the dataset in which it resides.
What if you run a function and you see a plus sign (+), rather than the > prompt? The plus sign is the
continuation prompt, meaning that R is waiting for more user input. The most common cause for this error
is having more open parentheses signs than closed parentheses signs in a statement, which tells R you hasn’t
finished calling a function yet. Either execute the right number of closing parentheses signs or click the “STOP”
button on the console window. (To wake up the STOP button, click in the Console window.) Parentheses,
brackets, and quotation marks come in pairs. Make sure each opening parenthesis “(” and opening bracket “[”
has a corresponding closing parenthesis “)” and closing bracket “]”. This can get a little confusing when you
write complex statements with nested functions. Develop the habit of typing a set of parentheses, quotations
marks, brackets, or braces anytime you use them, then move the cursor back inside the set to fill in values,
arguments, and so forth. Some script editors will do this automatically and that can be helpful.
If you copy and paste sample code from a Word document or web page, beware of curly quotation marks.
When you use single or double quotation marks in a word processor, the program uses “curly” quotation
marks for style. In contrast, your R script editor uses "straight" quotation marks. This can be a difficult bug to
spot in code.
If you run a number of statements at once and get a lot of error messages, locate the first line in your script
that prompted an error message—that’s probably where you need to start debugging. A small typo early in a
script can set off a chain reaction of errors. Don’t be alarmed by a cascade of errors and warnings: Just locate the
start of the error messages, read the message for any helpful information, and address one problem at a time.
In the following chapter of this book, we are going to show you how to conduct some fundamental analysis
using R. For particular methods, we will feature one function or set of functions. As mentioned above, there are
thousands of R packages and hundreds of thousands of functions. It should be no surprise, then, that there is a
lot of overlap among functions and there is often more than one way to solve a particular problem. In this book,
we emphasize functions with sensible default values, including handling of missing data, that allow researchers
to use sampling weights. We have only scratched the surface of R’s capabilities, but we believe the best way to
learn how to use R is hands-on experience solving problems with the program.
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EXERCISES

1. This chapter described R’s names function. Use the names function to find out which variables are contained
in the states dataset. Which of the following variables are in the states dataset? (Check all that apply.)
 cigarettes

no
t

 denom

 gunlaw_scale
 rep_therm

o

 partyid3

D

 attend_pct

2. Which of the following uses correct form in telling R where to locate the variable named gini10 in the world
dataset? (Check one.)
 gini10
 gini10$world
 world$gini10
3. The states dataset contains abortlaw10, the number of restrictions that each state puts on access to an
abortion. Values range from 0 (no restrictions) to 10 (ten restrictions). Use the freq command to obtain a
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frequency distribution and bar chart. (Hint: The states dataset does not require weighting, so you do not need
to include a weight variable in the freq expression.)
A. Print the graph.
B. Following this chapter’s printC example, create a nicely formatted table of the abortlaw frequency
distribution in a word-processing file, such as Word. When you edit the table in your word processor, give
it this title: “Number of Abortion Restrictions.” Print the formatted table.

e

4. Each time you start an R session using the R package that bundles the functions and dataset used in this
book, you must type and run which one of the following expressions? (Check one.)
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 ‘library(poliscidata)’
 ‘welcome()’
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 ‘help( )’
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